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Important Information
NOTICE Read these instructions carefully, and look at the equipment to become familiar with

the device before trying to install, operate, or maintain it. The following special
messages may appear throughout this documentation or on the equipment to warn of
potential hazards or to call attention to information that clarifies or simplifies a
procedure.
The addition of this symbol to a Danger or Warning safety label indicates that an
electrical hazard exists, which will result in personal injury if the instructions are
not followed.
This is the safety alert symbol. It is used to alert you to potential personal injury
hazards. Obey all safety messages that follow this symbol to avoid possible injury
or death.

DANGER
DANGER indicates an imminently hazardous situation which, if not avoided, will result in
death or serious injury.

WARNING
WARNING indicates a potentially hazardous situation which, if not avoided, can result in
death or serious injury.

CAUTION
CAUTION indicates a potentially hazardous situation which, if not avoided, can result in minor
or moderate injury.

CAUTION
CAUTION, used without the safety alert symbol, indicates a potentially hazardous situation
which, if not avoided, can result in equipment damage.

PLEASE Electrical equipment should be installed, operated, serviced, and maintained only by
qualified personnel. No responsibility is assumed by Schneider Electric for any
NOTE
consequences arising out of the use of this material.
A qualified person is one who has skills and knowledge related to the construction
and operation of electrical equipment and the installation, and has received safety
training to recognize and avoid the hazards involved
© 2008 Schneider Electric. All Rights Reserved.
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Before You Begin
Do not use this product on machinery lacking effective point-of-operation guarding. Lack of effective point-ofoperation guarding on a machine can result in serious injury to the operator of that machine.

WARNING
UNGUARDED MACHINERY CAN CAUSE SERIOUS INJURY
• Do not use this software and related automation products on equipment which does not have
point-of-operation protection.
• Do not reach into machine during operation.
Failure to follow these instructions can cause death, serious injury or equipment
damage.
This automation equipment and related software is used to control a variety of industrial processes. The type or
model of automation equipment suitable for each application will vary depending on factors such as the control
function required, degree of protection required, production methods, unusual conditions, government regulations,
etc. In some applications, more than one processor may be required, as when backup redundancy is needed.
Only the user can be aware of all the conditions and factors present during setup, operation and maintenance of the
machine; therefore, only the user can determine the automation equipment and the related safeties and interlocks
which can be properly used. When selecting automation and control equipment and related software for a particular
application, the user should refer to the applicable local and national standards and regulations. A “National Safety
Council’s” Accident Prevention Manual also provides much useful information.
In some applications, such as packaging machinery, additional operator protection such as point-of-operation
guarding must be provided. This is necessary if the operator’s hands and other parts of the body are free to enter
the pinch points or other hazardous areas and serious injury can occur. Software products by itself cannot protect
an operator from injury. For this reason the software cannot be substituted for or take the place of point-ofoperation protection.
Ensure that appropriate safeties and mechanical/electrical interlocks for point-of-operation protection have been
installed and are operational before placing the equipment into service. All mechanical/electrical interlocks and
safeties for point-of-operation protection must be coordinated with the related automation equipment and software
programming.
NOTE: Coordination of safeties and mechanical/electrical interlocks for point-of-operation protection is
outside the scope of this document.
START UP AND TEST
Before using electrical control and automation equipment for regular operation after installation, the system should
be given a start up test by qualified personnel to verify correct operation of the equipment. It is important that
arrangements for such a check be made and that enough time is allowed to perform complete and satisfactory
testing.
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CAUTION
EQUIPMENT OPERATION HAZARD
• Verify that all installation and set up procedures have been completed.
• Before operational tests are performed, remove all blocks or other temporary holding means
used for shipment from all component devices.
• Remove tools, meters and debris from equipment.
Failure to follow these instructions can result in injury or equipment damage.
Follow all start up tests recommended in the equipment documentation. Store all equipment documentation for
future reference.
Software testing must be done in both simulated and real environments.
Verify that the completed system is free from all short circuits and grounds, except those grounds installed
according to local regulations (according to the National Electrical Code in the U.S.A, for instance). If high-potential
voltage testing is necessary, follow recommendations in equipment documentation to prevent accidental equipment
damage.
Before energizing equipment:
• Remove tools, meters, and debris from equipment.
• Close the equipment enclosure door.
• Remove ground from incoming power lines.
• Perform all start-up tests recommended by the manufacturer.
OPERATION AND ADJUSTMENTS
The following precautions are from NEMA Standards Publication ICS 7.1-1995 (English version prevails):
• Regardless of the care exercised in the design and manufacture of equipment or in the selection and rating of
components, there are hazards that can be encountered if such equipment is improperly operated.
• It is sometimes possible to misadjust the equipment and thus produce unsatisfactory or unsafe operation. Always
use the manufacturer’s instructions as a guide for functional adjustments. Personnel who have access to these
adjustments should be familiar with the equipment manufacturer’s instructions and the machinery used with the
electrical equipment.
• Only those operational adjustments actually required by the operator should be accessible to the operator. Access
to other controls should be restricted to prevent unauthorized changes in operating characteristics.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Only use software tools approved by Schneider Electric for use with this equipment.
• Update your application program every time you change the physical hardware configuration.
Failure to follow these instructions can cause death, serious injury or equipment
damage.
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Introduction
Introduction

This document is intended to provide a quick introduction to the described system. It is not
intended to replace any specific product documentation, nor any of your own design
documentation. On the contrary, it offers additional information to the product documentation,
for installing, configuring and implementing the system.
The architecture described in this document is not a specific product in the normal commercial
sense. It describes an example of how Schneider Electric and third-party components may be
integrated to fulfill an industrial application.
A detailed functional description or the specification for a specific user application is not part of
this document. Nevertheless, the document outlines some typical applications where the
system might be implemented.
The architecture described in this document has been fully tested in our laboratories using all
the specific references you will find in the component list near the end of this document. Of
course, your specific application requirements may be different and will require additional
and/or different components. In this case, you will have to adapt the information provided in
this document to your particular needs. To do so, you will need to consult the specific product
documentation of the components that you are substituting in this architecture. Pay particular
attention in conforming to any safety information, different electrical requirements and
normative standards that would apply to your adaptation.
It should be noted that there are some major components in the architecture described in this
document that cannot be substituted without completely invalidating the architecture,
descriptions, instructions, wiring diagrams and compatibility between the various software and
hardware components specified herein. You must be aware of the consequences of component
substitution in the architecture described in this document as substitutions may impair the
compatibility and interoperability of software and hardware.
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Abbreviations
Abbreviation
AC
CB
DI
DO
DC
EDS
E-STOP
HMI
I/O
IL
LD
PC
PDO
PS
RPM
RPDO
SE
SDO
TPDO
TVDA
VSD
WxHxD
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Signification
Alternating Current
Circuit Breaker
Digital Input
Digital Output
Direct Current
Electronic Data Sheet
Emergency Stop
Human Machine Interface
Input/Output
Instruction List - a textual IEC-61131 programming language
Ladder Diagram - a graphic IEC-61131 programming language
Personal Computer
Process Data Object (CANopen)
Power Supply
Revolutions Per Minute
Receive Process Data Object (CANopen)
Schneider Electric
Service Data Object
Transmit Process Data Object (CANopen)
Tested, Validated, Documented Architectures
Variable Speed Drive
Dimensions: Width, Height and Depth
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Glossary

Expression
Altivar (ATV)
CANopen
Harmony
Magelis
MB – SL
Modbus
OsiSense
Phaseo
SoMove
Preventa
TeSys
Twido
TwidoSuite
Vijeo Designer
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Signification
SE product name for a family of VSDs
Name for a communications machine bus system
SE product name for a family of switches and indicators
SE product name for a family of HMI devices
SE name for a serial Modbus communications protocol
A communications protocol
SE product name for a family of sensors
SE product name for a family of power supplies
SE product name for a drive configuration software
SE product name for a family of safety devices
SE product name for a family for motor protection devices and
load contactors
SE product name of a basic range family of controllers
SE product name for a controller programming software
SE product name for Magelis HMI devices configuration software
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Application Source Code
Introduction

The example source code is in the form of configuration, application and import files. Use the
appropriate software tool to either open or import the files.

Extension
CFG
DOC
EDS
PDF
PSX
SPA
VDZ
XPR
ZW1

Optimized CANopen Twido

File Type
Export File (Multiloader Export)
Document file
Electronic Data Sheet - Device Definition
Portable Document Format - document
Project file
Schneider Product Archive
Project file
Project file
Project file

Software Tool Required
SoMove (Lite)
Microsoft Word
Industrial standard
Adobe Acrobat
SoMove (Lite)
TwidoSuite
Vijeo Designer
TwidoSuite
EPLAN P8
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Typical Applications
Introduction

Here you will find a list of the typical applications, and their market segments, where this
system or subsystem can be applied:
Packaging
•
•
•
•
•

Filling machines
Bottling machines
Wrapping machines
Corking machines
Pallet wrappers

Textile
•
•

Clothing machines
Sawing machines

Pumping
•
•
•
•

Booster stations
Compressors
Vacuum pumps
Hydraulic, Air, Filter pumps…

HVAC-R
•

Compressors

Other Machines
•
Wood working machines
•
Cutting machines
•
Sanders
•
Sawing machines
•
Industrial washing machines
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SPECIAL NOTE
The products specified in this document have been tested under actual service
conditions. Of course, your specific application requirements may be different from those
assumed for this and any related examples described herein. In that case, you will have
to adapt the information provided in this and other related documents to your particular
needs. To do so, you will need to consult the specific product documentation of the
hardware and/or software components that you may add or substitute for any examples
specified in this documentation. Pay particular attention and conform to any safety
information, different electrical requirements and normative standards that would apply to
your adaptation.
The application examples and descriptions contained in this document have been
developed based on products and standards available and defined for Europe. Some or
all of the application examples may contain recommendations of products that are not
available in your country or locality, or may recommend wiring, products, procedures or
functions that are in conflict with your local, regional or national electrical or safety codes
and/or normative standards.

NOTE:
The information in this document is based on European standards and may not be valid
for use in the U.S.A.
The use and application of the information contained herein require expertise in the
design and programming of automated control systems. Only the user or integrator can
be aware of all the conditions and factors present during installation and setup, operation,
and maintenance of the machine or process, and can therefore determine the automation
and associated equipment and the related safety provisions and interlocks which can be
effectively and properly used. When selecting automation and control equipment, and any
other related equipment or software, for a particular application, the user or integrator
must also consider any applicable local, regional or national standards and/or regulations.
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System
Introduction

The system chapter describes the architecture, dimensions, quantities, required
software and the different types of components used within this system.

Architecture
General

The controller in this application is a Twido. The user can control the application using the
Magelis HMI.
The variable speed drives, connected to the Twido via CANopen bus, are of the type
Altivar 312. An additional motor is driven by a TeSysU motor starter.
The example application includes two functional safety options:
1. A tamper free Emergency Stop function supervised with a Preventa safety module.
2. A second safety module to evaluate protective door guard function.

Layout
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Components

Hardware:

Software:

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Compact main switch NSX100F
Motor circuit breaker GV2L
TeSysD contactor LC1D
Altivar variable speed drive ATV312
TeSysU motor starter
Harmony XALK Emergency Stop switch with rotation release
Phaseo power supply ABL8
Modicon Twido modular controller
CANopen tap TSX
Magelis HMISTU655 Graphic display terminal
Harmony XB5 selector switches, push buttons and indicator lamps
Harmony tower light
Preventa guard switch with mechanical actuator XCS
Preventa safety module XPS
Multi 9 circuit breaker
Standard AC motor

• Twidosuite Version 2.20.11
• SoMove 1.2.4.0
• Vijeo Designer 5.1 SP1

Quantities of
Components

For a complete and detailed list of components, the quantities required and the order
numbers, please refer to the detailed components list in the appendix.

Degree of
Protection

Not all the components in this configuration are designed to withstand the same
environmental conditions. Some components may need additional protection, in the form
of housings, depending on the environment in which you intend to use them. For
environmental details of the individual components please refer to the list in the appendix
of this document and the appropriate user manual.

Cabinet
Technical
Data

Input

Mains voltage
Power requirement
Cable Size
Cable Connection

400 Vac
~ 3 kW
5 x 2.5 mm² (L1, L2, L3, N, PE)
3 phase + Neutral + Ground
Neutral is needed for 230 Vac (Phase and
Neutral)

Output

Motor power ratings

4 asynchronous motors (4 poles: 1500 RPM)
controlled by ATV312 (0.37 kW)
1 asynchronous motors (4 poles: 1500 RPM)
controlled by TeSysU (0.18 kW)
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Functional
Safety Notice
(EN ISO13849-1
EN IEC62061)

The standard and level of functional safety you apply to your application is determined by
your system design and the overall extent to which your system may be a hazard to
people and machinery.
Whether or not a specific functional safety category should be applied to your system
should be ascertained with a proper risk analysis.
This document is not comprehensive for any systems using the given architecture and
does not absolve users of their duty to uphold the functional safety requirements with
respect to the equipment used in their systems or of compliance with either national or
international safety laws and regulations

Emergency
Stop

Emergency Stop/Emergency Disconnection function
This function for stopping in an emergency is a protective measure which complements
the safety functions for the safeguarding of hazardous zones according to
EN ISO 12100-2.

Safety Function

Door guarding:
up to Performance Level (PL) = b, Safety Integrity Level (SIL) = 1

Dimensions

The compact dimensions of the devices used, for example, the controller and power
supply, enable the components to be installed inside a small control panel with the
following external dimensions: 800 x 1200 x 400 mm (WxHxD).
The display elements used to indicate “Plant Ready” and “Safety Acknowledged” can be
built into the door of the control cabinet along with the system master switch and
Emergency Stop switch.
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Installation
Introduction

This chapter describes the steps necessary to set up the hardware and configure the
software required to fulfill the described function of the application.

Assembly
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Notes

The components and I/O points listed below represent a cross-section of the
components and signals which can be used in conjunction with most typical applications
(functional safety/maintenance switches) and are a basic necessity for control and
display purposes and a number of optional inputs and outputs.
The components designed for installation in a control cabinet, example Twido, Phaseo
power supply unit, Harmony Emergency Stop switching device, line circuit breaker,
contactors and motor circuit breaker, etc. can be snapped onto a 35 mm DIN rail.
The Altivar variable speed drive is installed directly on the mounting plate.
Emergency Stop, main switch and HMI are installed in the cabinet door.
The Preventa guard switch is mounted in the field.
There are two options available for mounting Harmony XB5 push buttons and indicator
lamps:
a) Using a 22 mm hole drilled into the front door of the control cabinet in the
appropriate position.
b) Using XALD housing, this can house up to 5 push buttons or indicator lamps. This
XALD is designed for backplane assembly or direct wall mounting.

The individual components must be interconnected in accordance with the detailed
circuit diagram to help ensure that they function correctly.
•

400 Vac wiring between Compact main switch, motor circuit breaker, load relay
and variable speed drives.

•

24 Vdc wiring between power supply unit, Twido, push buttons, indicator lamps
and variable speed drive control circuit.

•

24 Vdc between Emergency Stop, Preventa, and the control circuit of the load
contactor.
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Twido inputs
I 0.0
I 0.1
I 0.2
I 0.3
I 0.4
I 0.5
I 0.6
I 0.7
I 0.8
I 0.9
I 0.10
I 0.11

Description
Not used, reserved for fast counters
Not used, reserved for fast counters
Safety Relay 1, Emergency Stop
Safety Relay 2, door guarding
Motor protection switch, drive 1
Motor protection switch, drive 2
Motor protection switch, drive 3
Motor protection switch, drive 4
Push button start
Push button stop
Not used
Not used

Twido outputs
Trans. Out Q0
Trans. Out Q1
Relay Out Q2
Relay Out Q3
Relay Out Q4
Relay Out Q5
Relay Out Q6
Relay Out Q7

Description
Pilot light, acknowledge button, Emergency stop
Pilot light, acknowledge button, door guarding
Pilot light, start button
Pilot light, stop button
Pilot light, plant ready for operation
Not used
Not used
Not used

Digital I/O-Module inputs
all inputs

Description
Not used

Digital I/O-Module outputs
Relay Out Q0
Relay Out Q1
Relay Out Q2
Relay Out Q3
Relay Out Q4
Relay Out Q5
Relay Out Q6
Relay Out Q7

Description
Tower light, green indicator lamp
Tower light, red indicator lamp
Tower light, blue indicator lamp
Tower light, white indicator lamp
Not used
Not used
Not used
Not used

Analog
extension
module

Analog I/Os
all inputs and outputs

Description
Not used

Thermocouple
module

Connections
Out0
In0
In1

Description
Not used
Temperature sensor Pt100
Temperature sensor Pt100

Twido CANopen module
COM

Description
CANopen bus communication

Twido 24 Vdc supply
COM
COM+
-V
COM 1
COM 2
COM 3

Description
Supply inputs 0 Vdc
Supply outputs +24 Vdc
Supply outputs 0 Vdc
Supply outputs +24 Vdc
Supply outputs +24 Vdc
Supply outputs +24 Vdc

Twido
I/O Wiring

Digital
extension
module
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Hardware

Main Switch
Compact

NSX100F

Emergency Stop
for door mounting
Harmony

XB5AS844 +
XB5AZ141
Incl. Emergency Stop
Label
ZBY8330

Emergency Stop
Safety Module
Preventa
XPSAC5121
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Guard switch
Preventa
XCSA502

Indicator Press
Button
Harmony

XB5

Motor circuit
breaker
TeSys

GV2L07

Contactor
TeSysD

LC1D09BD

Optimized CANopen Twido
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Power supply
Phaseo

ABL8RPS24050
24 Vdc, 5 A

Twido
Logic controller
Modular device
TWDLMDA20DRT

12 digital inputs
8 relay outputs

A = Input wiring positive logic
B = Input wiring negative logic

Twido
Analog expansion
module
TM2ALM3LT

2 analog inputs
1 analog output
12 bit
(1)

Voltage/current preactuator

Module covers thermocouple
(types J, K and T) and
temperatureprobe (Pt100)
Note:
For 4 wires A’ is not connected
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Twido
Analog expansion
module
TM2AMM6HT

4 analog inputs
2 analog output

(1)

(2)

Voltage preactuator

Current preactuator

Use the braid supplied with the
module to connect the functional
ground
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Inputs

Twido
Digital expansion
module
TM2DMM24DRF

16 digital inputs
8 digital outputs

A = Input wiring positive logic
B = Input wiring negative logic
Outputs

Twido
Interface Module
CANopen Master

TWDNCO1M
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Operator panel
Magelis HMI
HMISTU655

A Magelis STU Small Panel is made up of a front module (comprising
the screen) and a rear module (comprising the CPU plus terminals and
connectors). The two modules are fixed together by means of a hole
measuring 22mm in diameter. The fixing system contains the following
elements:
(6) An adjusting nut
(7) A seal
(8) An anti rotation tee (can be used as an option)
(9) A release mechanism: simply press to separate the two
modules once they have been fixed together
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Variable Speed
Drive
Altivar 312

ATV312H037N4
3-phase,
400 Vac, 0.37 kW

Motor Starter
TeSysU

Power base
two directions
LUB12BL

Coil wiring kit
LULC08
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Motor Starter
TeSysU

Control Unit
LUCA05BL

Motor Starter
TeSysU

CANopen
communication
module
LULC08

Optimized CANopen Twido

1. 24 Vdc power
Supply
2. Terminal for coil wiring
kit
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Software
General

TwidoSuite is used for programming the Twido, including the configuration for
communication and assigning inputs and outputs.
The HMI application on the Magelis operator terminal is configured using Vijeo Designer
software.
The Altivar 312 variable speed drive can be configured using the keypad panel. However,
the SoMove software is a more user-friendly option and can be used for parameterizing
the drive, saving data and quickly restoring existing data for service purposes. The
software can also help you to optimize the parameters online.
To use the software packages, your PC must have the appropriate Microsoft Windows
operating system installed:
•

Windows XP Professional

The default installation path on the hard drive of your PC for each of the software tools is:

TwidoSuite
C:\Program Files\Schneider Electric\TwidoSuite

Vijeo Designer
C:\Program Files\Schneider Electric\Vijeo-Designer

SoMove Lite
C:\Program Files\Schneider Electric\SoMove Lite
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Communication
General

A Modbus connection is used to exchange data between the Magelis HMI terminal and
the Twido. The XBTZ9780 communication cable shown below is required to connect
these two devices. The software driver required for Modbus communication is already
included in the software packages for the Magelis panel and the Twido.
A CANopen link is used to connect the controller, the Altivar 312 and the TeSysU device.
The different cables, adapters and connectors are explained on the following pages to
allow the wiring inside the cabinet.
This chapter describes the hardware used for data communications (CANopen) and how
to use the programming cables used in configuring the individual devices in the system.

HMI
HMI <> PC

HMISTU terminals can be connected to the PC in two
different ways:
-

via USB port
via Ethernet

Download cable
PC <> HMI
BMXXCAUSBH018

Communication Cable
HMI <> controller
XBTZ9780

Optimized CANopen Twido
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Controller
Communication cable
with USB connector
PC <> Twido
TSXCRJMD25
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To program the Twido, use the cable TSXCRJMD25 with
the RS845 adapters (TSXCUSB485) to connect the PC
with the Twido.
Verify that the adapter is in switch position 2.
For the communication to work properly, port 1 must be
configured on the Twido
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Altivar 312
USB cable for
SoMove Lite
TCSMCNAM3M002P

CANopen
CANopen topology
used in this architecture
The picture shows where
the CANopen bus needs
to be terminated.
Precondition for the
terminating resistors is
that the entire cable
length of the stub
(connected to connection
1 on the CANopen TAP)
is shorter than the cables
between Twido and
CANopen TAP and
TeSysU and CANopen
TAP.
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CANopen
Master Module
TWDNCO1M
The CANopen Interface
Module is plugged into
the Twido and has a
SUB-D9 CANopen
connection

Altivar 312
CANopen
daisy chain option

Node ID: 1, 2, 3 and 4

ATV312
CANopen option card
daisy chain option
VW3A31208

Optimized CANopen Twido
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ATV312
CANopen
daisy chain option card
VW3A31208

TeSysU CANopen
communication module
LULC08

Node ID: 5

TeSysU CANopen
communication module
LULC08
The baudrate is set to
500 kbps.
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TeSysU CANopen communication module
The following address is used: Node ID: 5

CANopen Connector
TSXCANKCDF90T
Use this connector on the
TWDNCO1M. Connector
includes a terminal
resistor.

CANopen cable
TSXCANCD50
Flexible Cable
CANopen TAP
TSXCANTDM4

Terminal resistor can be
selected using the
ON /OFF switch.
The image shows the
resistor set to OFF.
As TeSysU bus module
requires a 24 Vdc power
supply, this needs to be
wired on the CANopen
out of the CANopen TAP.
CANopen cable
TCSCCN4F3M1T
Connects from the
CANopen TAP to the
first Altivar 312.
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CANopen
pre-assembled
connection cable
VW3CANCARR03
(length: 0,3m)

Used for connecting ATV312 in a daisy chain
connection.
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Implementation
Introduction

The implementation chapter describes all the steps necessary to initialize, configure,
program and start-up the system to achieve the application functions as listed below.

Function

Start-up and functional description
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.

Switch on all circuit breakers. The main switch is off.
Verify that the Emergency Stop has not been activated
Switch on at the main switch
Check the door guard switch
Acknowledge the Emergency Stop and door guard switch
The start-up screen is shown on the HMI touch screen
Press the Bus button on the right to open the CANopen status page
Wait until all devices show a green status field and press the Control Dev. 1-3 (panel
for Altivar 1..3) or Control Dev. 4&5 button (panel for Altivar 4 or TeSysU)
Select from the control screen per Altivar the setpoint speed, forward, reverse or stop.
Press the Control Dev. 4&5 button (panel for Altivar 4 and TeSysU)
Select from the control screen per Altivar the setpoint speed, forward, reverse or stop.
For TeSys U select only forward or revers.
In case an alarm occurs the alarm button in the right down corner will turn red. Press
the alarm button to open the alarm summary page.

Functional
Layout
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Communication
Introduction

This chapter describes the data passed via the communications networks (e.g.
CANopen or Modbus) that is not bound directly with digital or analog hardware.
The list contains:
• The device links
• Direction of data flow
• Symbolic name and
• Bus address of the device concerned.

Device Links

This application uses Modbus and CANopen networks.
Modbus connects:
•
Magelis Panel as Modbus master
•
Twido as Modbus slave (address 1)
CANopen connects the following devices:
• Twido CANopen master module (address 127)
• Altivar 312 variable speed drives (addresses 1..4)
• TeSysU reverse motor starter (address 5)

Datalink
HMI Æ Twido

Device 1
HMISTO511 (Modbus master)
Address
%M11
%M12
%M13
%M21
%M22
%M23
%M31
%M32
%M33
%M41
%M42
%M43
%M51
%M52
%M53
%M100
%MW1
%MW11
%MW12
%MW13
%MW14

Optimized CANopen Twido

Designation
HMI_Slave_1_FWD
HMI_Slave_1_REV
HMI_Slave_1_STOP
HMI_Slave_2_FWD
HMI_Slave_2_REV
HMI_Slave_2_STOP
HMI_Slave_3_FWD
HMI_Slave_3_REV
HMI_Slave_3_STOP
HMI_Slave_4_FWD
HMI_Slave_4_REV
HMI_Slave_4_STOP
HMI_Slave_5_FWD
HMI_Slave_5_REV
HMI_Slave_5_STOP
HMI_Alarm_Reset
HMI_Panel_ID_Current
HMI_Slave_1_SP
HMI_Slave_2_SP
HMI_Slave_3_SP
HMI_Slave_4_SP

Device 2
Twido (Modbus slave 1)
Address
%M11
%M12
%M13
%M21
%M22
%M23
%M31
%M32
%M33
%M41
%M42
%M43
%M51
%M52
%M53
%M100
%MW1
%MW11
%MW12
%MW13
%MW14

Name
HMI_SLAVE_1_FWD
HMI_SLAVE_1_REV
HMI_SLAVE_1_STOP
HMI_SLAVE_2_FWD
HMI_SLAVE_2_REV
HMI_SLAVE_2_STOP
HMI_SLAVE_3_FWD
HMI_SLAVE_3_REV
HMI_SLAVE_3_STOP
HMI_SLAVE_4_FWD
HMI_SLAVE_4_REV
HMI_SLAVE_4_STOP
HMI_SLAVE_5_FWD
HMI_SLAVE_5_REV
HMI_SLAVE_5_STOP
HMI_CLEAR_ERROR
HMI_PANEL_ID_CURRENT
HMI_SETP_SLAVE_1
HMI_SETP_SLAVE_2
HMI_SETP_SLAVE_3
HMI_SETP_SLAVE_4
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Datalink
Twido Æ HMI

Device 1
HMISTO511 (Modbus master)
Address
%M2
%M101
%M102
%M103
%M104
%M105
%M106
%M107
%M108
%MW2
%MW11
%MW12
%MW13
%MW14
%MW20:X0
%MW20:X1
%MW20:X2
%MW20:X3
%MW20:X4
%MW20:X5
%MW31
%MW32

Datalink
Drive1 Æ
Twido

Twido Æ
Drive1

Datalink
Drive2 Æ
Twido

Twido Æ
Drive2

Designation
HMI_global_Alarm_Stat
HMI_Alarm_01
HMI_Alarm_02
HMI_Alarm_03
HMI_Alarm_04
HMI_Alarm_05
HMI_Alarm_06
HMI_Alarm_07
HMI_Alarm_08
HMI_Panel_ID_Next
HMI_Slave_1_SP
HMI_Slave_2_SP
HMI_Slave_3_SP
HMI_Slave_4_SP
CANopen_Master_OK
CANopen_Slave_1_OK
CANopen_Slave_2_OK
CANopen_Slave_3_OK
CANopen_Slave_4_OK
CANopen_Slave_5_OK
HMI_Temp_1
HMI_Temp_2

Device 2
Twido (Modbus slave 1)
Address
%M2
%M101
%M102
%M103
%M104
%M105
%M106
%M107
%M108
%MW2
%MW11
%MW12
%MW13
%MW14
%MW20:X0
%MW20:X1
%MW20:X2
%MW20:X3
%MW20:X4
%MW20:X5
%MD31
%MD32

Name
STATUS_ALARM_SUMMARY
HMI_ALARM_01
HMI_ALARM_02
HMI_ALARM_03
HMI_ALARM_04
HMI_ALARM_05
HMI_ALARM_06
HMI_ALARM_07
HMI_ALARM_08
HMI_PANEL_ID_NEXT
HMI_SETP_SLAVE_1
HMI_SETP_SLAVE_2
HMI_SETP_SLAVE_3
HMI_SETP_SLAVE_4
CANOPEN_MASTER_OK
CANOPEN_SLAVE _1_OK
CANOPEN_SLAVE _2_OK
CANOPEN_SLAVE _3_OK
CANOPEN_SLAVE _4_OK
CANOPEN_SLAVE _5_OK
HMI_TEMPERATURE_1
HMI_TEMPERATURE_2

Drive 1
Altivar (CANopen slave 1) to Twido (CANopen master)
Address
%IWC1.0.0
%IWC1.0.1
%IWC1.0.2
%IWC1.0.3

Designation
D_STATUS_SLAVE_1
D_CONTROL_SLAVE_1
D_IERROR_SLAVE_1
D_MCURRENT_SLAVE_1

Twido (CANopen master) to Altivar (CANopen slave 1)
Address
%QWC1.0.0
%QWC1.0.1

Designation
D_COMMAND_SLAVE_1
D_TARGET_SLAVE_1

Drive 2
Altivar (CANopen slave 2) to Twido (CANopen master)
Address
%IWC1.1.0
%IWC1.1.1
%IWC1.1.2
%IWC1.1.3

Designation
D_STATUS_SLAVE_2
D_CONTROL_SLAVE_2
D_IERROR_SLAVE_2
D_MCURRENT_SLAVE_2

Twido (CANopen master) to Altivar (CANopen slave 2)
Address
%QWC1.1.0
%QWC1.1.1

Optimized CANopen Twido
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Datalink
Drive3 Æ
Twido

Twido Æ
Drive3

Datalink
Drive4 Æ
Twido

Twido Æ
Drive4

Datalink
TeSysU Æ
Twido
Twido Æ
TeSysU

*)

Drive 3
Altivar (CANopen slave 3) to Twido (CANopen master)
Address
%IWC1.2.0
%IWC1.2.1
%IWC1.2.2
%IWC1.2.3

Designation
D_STATUS_SLAVE_3
D_CONTROL_SLAVE_3
D_IERROR_SLAVE_3
D_MCURRENT_SLAVE_3

Twido (CANopen master) to Altivar (CANopen slave 3)
Address
%QWC1.2.0
%QWC1.2.1

Designation
D_COMMAND_SLAVE_3
D_TARGET_SLAVE_3

Drive 4
Altivar (CANopen slave 4) to Twido (CANopen master)
Address
%IWC1.3.0
%IWC1.3.1
%IWC1.3.2
%IWC1.3.3

Designation
D_STATUS_SLAVE_4
D_CONTROL_SLAVE_4
D_IERROR_SLAVE_4
D_MCURRENT_SLAVE_4

Twido (CANopen master) to Altivar (CANopen slave 4)
Address
%QWC1.3.0
%QWC1.3.1

Designation
D_COMMAND_SLAVE_4
D_TARGET_SLAVE_4

TeSysU
TeSysU (CANopen slave 5) to Twido (CANopen master)
Address
%IWC1.4.0
%IWC1.4.1

Designation
TPDO_1_2004SUB6 (internal TeSysU status register 455) *)
TPDO_1_2004SUB9 (internal TeSysU status register 458) *)

Twido (CANopen Master) to Altivar (CANopen Slave 5)
Address
%QWC1.4.0
%QWC1.4.1
%QWC1.4.2

Designation
RPDO_1_2008SUB5 (internal TeSysU control register 704) *)
RPDO_2_2008SUB4 (internal TeSysU control register 703) *)
RPDO_3_2008SUB1 (internal TeSysU control register 700) *)

only the first input word and output word are used in this example

Optimized CANopen Twido

Schneider Electric

37

Controller

Introduction

This chapter describes the steps required for the initialization and configuration and the
source program required to fulfill the functions.
The controller program is created using TwidoSuite.

Requirements

To use TwidoSuite and program the Twido first verify that:
•
•
•
•

Procedure

Create a new
project

TwidoSuite is installed on your PC
The example application, TwidoSuite project Opimized_CANopen_Twido.xpr, is in
the standard project directory (C:\Program Files\Schneider Electric\TwidoSuite\My
Projects)
The Twido is switched on
The Twido is connected to the PC using the proper programming cable

Programming the controller consists of:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Create a new project
Configure the Twido
Configure the Modbus for HMI
Import EDS-file for TeSysU
Configure the CANopen devices
CANopen module configuration
Activate the Altivar drive macros
Create variables
Create an Application Program
Insert Macros for ATV drives
Control commands for TeSysU
Save / export a project
Open / import a project
Connecting to a Twido
Download a project
Download firmware

1

To create a new project click on
the arrow next to
’’Programming’’ Mode

Optimized CANopen Twido
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2

Select the Project tab and click
on:
Create a new project

3

Enter the project information as
required:
•
•
•
•
•
•

Project name
Directory path for save
Author
Department
Index
Industrial Property

Continue with Create.

Configure the
Twido

1

To configure the hardware, the
communication parameters and
bus system, click on the
Describe tab.

2

From the Catalog on the right
select the Twido type:
Bases->
Modular->
TWDLMDA20DRT
Click on Place to see the Twido
in the image of the rack.
Pick the Twido from the list and
drag it into the page. A green
square indicates the possible
position.
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3

Again in the Catalog, for the
communications module,
select:
Expansions modules->
Communication Expansion->
CANopen->TWDNCO1M
Click on Place and drag the
item to the worktop to see the
communications module show
up in the image of the rack.
Continue appending local I/Os
like digital or analog inputs and
outputs as described above.
In this configuration following
modules are used additionally:
• TM2DMM24DRF
• TM2ALM3LT
• TM2AMM6HT

4

The module TM2ALM3LT in this
setup needs to be configured as
it is a multipurpose analog
temperature module.
Click on the upper half of the
module to open the
configuration.

5

The I/O-mapping of the module
is displayed in the lower part of
this configuration screen.

6

In this example the Type of
input is for both PT100, which
you select from the drop-down
list. The output remains unused.

7

Select from the Scope dropdown list Celsius.
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8

Configure the
Modbus for HMI

1

The analog channels are now
configured in terms of input type
including also the correct range.

Again in the Catalog, for the
communications module, select:
Network Elements->
Modbus Elements->
Magelis
Pick and place it on the worktop.

2

To configure the
communications port for the HMI
connection, right mouse click on
the RS485-Port on the image of
the Twido and select
Configuration…
in the pop-up menu.

3

Select:
Type: Modbus
Address: 1
Continue with OK.

Optimized CANopen Twido

Schneider Electric

41

4

To configure the communication
port of the HMI, right mouse
click on the HMI image and
select
Configuration…
in the pop-up menu.

5

Insert:
Name: for example, the HMI
type HMISTU655
Type: Modbus
Address: Master

Continue with OK.

6

Now connect the HMI and the
Twido with a line. Place the
mouse at the end of the Twido
port; the view changes. Hold the
right mouse button and draw a
line to the point below the HMI
image.
Release the mouse button and
the connection, my network 1 is
shown. Double click on:
my network 1
to open the configuration box.
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7

Use the following parameter
values:
Baudrate: 19200
Data Bits: 8(RTU)
Parity: none
Stop Bit: 1
Confirm with OK.

Import EDS-file
for TeSysU

1

If a device is not existent in the
catalog, you must import the
needed eds-file for the
CANopne configuration.
Right mouse click on
CANopen elements -> Import

2

Select the corresponding file in
the project folder
TESYSU_SC_ST_0102E.eds

3

The new device is now available
in the catalog.
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Configure the
CANopen
devices

1

2

First configure the hardware, then activate and define the slaves.
Without activation this slave is only shown in the hardware configuration, highlighted
in red, but the CANbus communication is inactive. This could be helpful for example,
to test a single drive of a machine.
The next step is to add the
CANopen slaves.
Network Elements
Æ CANOpen Elements
Æ (DS-402) Drives and Motion
Control
Æ ATV31_V1.2
Æ Basic_ATV31

Pick and drop at workspace:
4x ATV31
1x TeSysU (see next chapter)

3

Note;
Altivar 312 is fully compatible
with the Altivar 31 regarding
mechanical characteristics and
software. The ATV31 devices
shown and described in this
example are already integrated
in Twido delivery and software
installation by default.
Connect the CANopen master
module and the slave with a
line.
Place the mouse at the end of
the CANopen port; it changes
the view. Hold the left mouse
button and draw a line to the
point below the slave image.
Release the mouse button and
the connection my network 2 is
shown.

Double click on:
my network 2
to open the configuration dialog
box.
4

In this application following
parameters are used:
Baudrate: 500 Kbps
Supervision: 300 ms

Confirm with OK.
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5

Repeat steps 2 & 3 to add the
next ATV312 slaves.
Connect slave 1, 2, 3, 4 with a
line.

6

To add the TeSysU click in the
catalog on:
Network Elements
Æ CANOpen Elements
Æ (DS-0)
Æ TeSysU_Sc_St (V1.20)

7

Now connect the TeSysU to the
last Slave.

8

Double click on the CANopen
connector image of the
CANopen module to open up
the linking configuration.
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9

The Linking dialog box shows
you on the right hand side the
PDOs (Process Data Objects)
which have already been linked
(Altivar slaves 1..4) and on the
left hand side the ones which
have not been linked so far
(TeSysU slave 5).

10 To convert a not-linked to a
linked PDO:
(1) Click the first PDO TX 1
(2) Click on the arrow
symbol at the top

11 The PDO TX 1 appears now in
the list of linked PDOs on the
right.
Note:
This PDO transmits the TeSysU
module status to the Twido.

12 Change now to the receive
PDOs by selecting Receive
from the Type drop-down list.
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13 Proceed in the same way as you
did with the transmit PDOs:
(1) Click the first PDO RX 1
(2) Click on the arrow
symbol at the top

14 The PDO RX 1 appears now in
the list of linked PDOs on the
right.
Note:
This PDO receives the control
word from the Twido.

Close the Linking dialog box by
clicking OK.

CANopen
module
configuration

1

To open directly the
CANopen module configuration
click on the upper half of the
CANopen module.
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2

Alternatively you can go to the
Module configuration with:
(1) Program
(2) Configure
(3) Configure the
Hardware
Slave 1 is highlighted in the
figure. The table on the right
shows the addresses and the
descriptions of the default
parameters.

3

4

5

Drive macros for the Altivar
devices have already been
created automatically and are
displayed in the table at the
bottom.
The Used column indicates
whether it is used in the
programming code. The
Address is the variable address
in programming code, Symbol is
the symbolic name and Object is
a description.
By clicking on Slave_5 you find
the corresponding objects and
addresses in the list on the right.

In this list you can type in your
own Symbols for a clear
identification in your program.
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Activate the
Altivar drive
macros

1

Click on:
(1) Configure the data
(2) Advanced objects
(3) Macros Drive
(4) Activate the slave in the column Conf. and
(5) select CANopen as Network with the respective Network Address (1..4).

(6) In the column Start address enter for this example 100, 200, 300, 400 for
the ATV drives. Confirm with Enter. The predefined length is a block of 30
words for each drive.
(7) Mark the checkbox Symbols to get the predefined tags for the words used
by the macro.
2

The slaves are now configured and ready for use in the programming code.
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Create
Variables

Two different variable types are possible:
- I/O variables, linked to inputs or outputs
- internal variables, such as bit, byte, word, double word, floating point and constant
The variables can be defined in separate lists or entered directly in the programming
editor (list or ladder).
1 To create I/O variables, open
the Module configuration with
(1) Program
(2) Configure
(3) Configure the
Hardware
(4) Then click the relevant
I/O module.
The table at the bottom of the
screen shows the I/O variables.

2

The following is shown in the
table:
Used: indicates whether the
variable is used in the
programming code
Address: the I/O address
Symbol: the symbolic variable
Used By: user logic or empty
Filtering: minimum signal time
length (only for inputs)

3

Confirm with Apply.
The image shows how the
variables in the table above are
used in the program:
%I0.1 – E_STOP: variable and
symbolic name in program code
%I0.2: variable without symbolic
name in program code
%I0.3 - START: the symbolic
name is in the variable list (see
image above) but not used in
the program.
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4

To create internal variables,
open the Module configuration:
Program->
Configure the Data->
Simple Objects
The table, bottom left, lists the
datatypes: %M, %MW, %MD,
etc.
A table with addresses and
symbolic names for each data
type is shown on the right.
Used: indicates whether the
variable is used in the program
%Mx: variable address
Symbol: symbolic variable

Create an
Application
Program

1

Go to the program editor with:
Program->Edit Program
A new program always begins
with LADDER as the
programming language.
You can only view the program
in LIST mode once the first rung
has been completed and
analyzed.

2

Start the programming with:
add a section.
This creates a section with
empty rungs.

3

Click on the header of a
Section to enter a description
(for example “Safety”).

Click on the header of a rung to
enter a description.
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5

To add contacts, click on the
rung. The rung changes its
color and indicates the current
rung is being edited.
Clicking on an icon in the
toolbar inserts the selected
object at the first available place
on the rung.

6

Add coils in the same manner.

7

To make a logical connection,
simply mark the source and pull
it to the destination. All possible
connecting points are shown in
same color.

8

Once a link has been inserted,
you can add a contact to form a
logical OR.

9

To assign an object to an
address or variable, click on the
upper half of the object.
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10 The editor automatically
recognizes whether a rung is
syntactically complete and
marks it in yellow.
The rung, however, has not yet
been analyzed.

11 The analysis is done for all
contacts.

12 Analyze the program code by
clicking on the icon in the
bottom right hand corner of the
window.
The message box to the left of
the icon shows if there are any
compilation errors.

13 If the analysis is successful, the
red band changes to green.
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14 If compilation errors are found,
they are listed at the bottom of
the edit field. Click on the arrow
icon on the right side of the
message box to enlarge it.
A common compilation
message may be:
No Start In Run Was Selected
15 To fix this, select:
Program->
Configure->
Configure the behavior ->
and for Startup activate:
Automatic start in Run
This is an operation mode that
causes the Twido to start up
automatically on return of power
after a power interruption.
16 After restarting the analysis, the
notification field is empty.

Insert Macros 1
for ATV Drives

To use the macros for the
drives, a second Rung is added
using the add a rung function.

2

Insert an operation block for the
macro.
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3

To link the operation block to the
macro drive input D_manager 1.
D_manager is the macro function
to access the drive and the 1
indicates Drive 1.
The space between D_manager
and the 1 is mandatory.
Since the macro is already
configured, the address field also
contains the symbolic macro
name D_MANAGER 1.
The SHORT (see next step)
must be exchanged for a control
variable.
You can now repeat this for the
other macros:
D_CLEAR_ERR
D_RUN_FWD
D_RUN_REV
D_STOP
D_SELECT_SPEED

4
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Control
commands
for TeSysU

1

For TeSysU no specific macro
Statuswords: TeSysU Æ Twido
are required. The commands
forward, reverse and stop can
be controlled by using the linked
PDOs,
The PDO mapping for all
TeSysU modules are the same,
but not all modules use or
provide the bits which are
predefined in these transfer
words.
The TeSys U Sc St module in
this example (standard starter
controller module) provides as
status to the Twido
- status register
- I/O module status
register

The TeSysU module commands
for start and stop are controlled
only by the first transfer word
(Word 1).
Forward and reverse command
are bitwise controlled. If both
bits are switched back to zero
(low signal) TeSysU module
stops.

Control words: Twido Æ TeSysU

Note:
The graphics on the right show
only the used bits within the
CANopen objects for this type
of module.
2

You find the correct input and
output word for control and
staus of the TeSysU by opening
the CANopen module
configuration.
According to this example the
address of the first output word
is %QWC1.4.0.

Optimized CANopen Twido

Schneider Electric

56

3

To write the commands to the
TeSysU the control word has to
be provided with only one
command active at a time with
maximum one bit set.
Put following equation in the
rung of your program to achieve
the respective command:
Forward Æ 16#1
Reverse Æ 16#2
Stop Æ
16#0

Save / Export
a project

1

To save the project select Save
current project in the project
menu.
In the Save current project
window you can select the
folder for the save, input the
File name and select
TwidoSuite Project from the
Format drop-down list.

Note:
You can save the file also as an
archive file. The archive file has
the advantage of being portable
and is a single file.
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Open / import
a project

1

To open a project use the Open
an existing project function in
the project menu.
In the open an existing project
window select the medium:
Disk or Controller
by clicking the radio button.
Choose the file type under
Format (for a project file:
Project), select the folder and
select the File you wish to
open.
When ready click on Open to
open the project.

For import the action is the
same, except the file Format is
TwidoSuite Archive.

Connecting to
the Twido

1

To connect the PC to the Twido
select Program in the main
menu, then Debug in the submenu to get access to the
Connect selection.
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2

The available communication
ports are shown.
Check that the the
TSXCUSB485 adapter is
connected, and select the
linked COM port.
Continue with OK.

3

Note:
If you don’t know which COM
port is assigned to the
TSXCUSB485 adapter continue
with step 3. If you already know
the COM port go directly to
step 5.
The TSXCUSB485 adapter is
linked by Windows to a virtual
COM port. To identify the right
COM port you need to open the
System Properties dialog by
clicking on Windows key +
Pause button.
Open up the Hardware tab and
click on Device Manager.

4

In the Device Manager click on
Ports (COM & LPT).
The TSX C USB 485 adapter is
listed with the corresponding
port in brackets. In this case the
port COM19 is assigned to it.
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Download a
project

5

A progress bar is displayed
while TwidoSuite establishes
the connection.

1

After successfully connecting to
the Twido, TwidoSuite
compares the project in the
Twido and the opened project.
You can now either download
your project or upload the
contents of the Twido

2

To download the project select:
Transfer PC ==> controller

and confirm with OK.

3

If the Twido is already running it
must be stopped first.
Confirm with OK if you wish to
proceed.

4

You will be informed that the
contents of the Twido are about
to be overwritten.
Confirm with OK to continue.
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5

The download status is
indicated with a process bar.

6

After a successful download,
TwidoSuite changes to online
viewing mode.

7

A control panel is shown so you
can start and stop the Twido.
The upper button extends the
window, offering more Twido
status information.

8

If you start the Twido, the action
must be confirmed.
Click OK to proceed.

9

After successfully starting the
Twido, the RUN LED changes
from yellow to green.

Optimized CANopen Twido

Schneider Electric

61

10 The image on the right shows
the expanded control panel with
the Twido in run mode.

11 If the control panel is closed, a
click in the upper left hand
corner of the main window reopens it.

12 The sub-menu Manage
animation tables allows access
to the animation tables.
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13 Use the project browser to
navigate through the program
sections.

Download
firmware

1

Ensure you have connected the
Twido with the USB cable.
Select:
PLC firmware update

2

You are notified that the
firmware download will delete
any program running on the
Twido.
Continue by clicking Next >.
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3

Select the correct Connection
port. In this case select
COM19. (corresponding to the
settings of the TSXCUSB485
adapter in your Windows
Device Manager for the COM &
LPT ports)
Select the file to be
downloaded with Browse…
button.
Click on Next > to continue.

4

Note:
The firmware files are not part
of the software delivery and
needed to be downloaded
separately from the Schneider
Electric webpage.
A comparison of the hardware
and existing firmware is shown,
as well as the controller state. If
the controller is in the running
state, it must be stopped before
the firmware can be updated.
Click on Stop Controller.

5

Confirm the stop with Yes.
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6

The new Twido status is
displayed in File and Device
Properties (green tick in
Stopped).

Continue with Next >.

Note:
Updating the executive of your
controller will delete the current
control application from the
controller Memory. You will
have to reload the program
after updating the controller.
7

Confirm the notification not to
interrupt the download with
Yes.

8

A progress bar is displayed.

9

A message confirms the
successful download and asks
if you wish to download more.
Click on No if you are finished.
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10

In the progress dialog click on
Close.

11

Click on Yes to exit the loader.
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HMI
Introduction

In this application a Magelis HMISTU655 touch display is implemented. The display
communicates via Modbus protocol with the Twido.
Configuration and programming of the display is done using the Vijeo Designer HMI
software.

Requirements

Before starting with Vijeo Designer the following preconditions must be met:
•
•
•

Procedure

Create a new
configuration

Vijeo Designer software is installed on your PC
The project Optimized_CANopen_Twido.vdz has been copied on the PC
The Magelis HMI is switched on and connected to the PC with the cable
BMXXCAUSBH018

Setting up the HMI is done as follows:
•
•
•
•
•
•
•
•
•
•
•

Create a new configuration
Main window
Configure the connection
Create a new variable
Create a switch
Create a numeric display
Create an alarm and alarm panel
Export Vijeo Designer project
Import Vijeo Designer project
Download program to the HMI
Screen navigation in the application program

1

When Vijeo Designer starts a
welcome screen is opened.
Select Create new Project
from the list and click on
Next >.
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2

In the field Project Name you
need to give a name for the
project, for this example
Optimized_CANopen Twido has
been entered.
You can type in as well a
description or comment.
For this architecture the HMI is
only connected to one controller
so the Type of this example is
Project with single target.
Continue by clicking Next >.

3

Select the following target type
and model from the drop down
list:
Target Name:
Optimized_CANopen_Twido

Target Type:
HMISTU series
Model:
HMISTU655 (320x240)
Click on Next > to continue.

4

Leave this screen as it is
without checking any box and
continue by clicking Next >.
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5

To communicate with external
controllers, additional drivers are
needed. Click on Add to open a
selection window.

6

Select from the New Driver
dialog the following settings:
Manufacturer:
- Schneider Electric
Industries SAS
Driver:
- Modbus (RTU)
Equipment:
- Modbus Equipment
Close the window by clicking
OK.

7

The Modbus RTU driver is now
added to the equipment list.
To continue press Finish.
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Main Window

1

After creating a Vijeo Designer
HMI project the main window of
Vijeo Desinger is displayed.
Vijeo Designer has the following
components:
1. Navigator
2. Info viewer
3. Toolchest
4. Property Inspector
5. Feedback Zone
6. Graphic List

Configure the
connection

1

The Navigator browser lists the
different elements of the HMI
project.
Right click on
ModbusEquipment01.
Select Configuration in the
pop-up menu.
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2

The Equipment Configuration
dialog opens.
The Slave Equipment Address
is already set to 1 which
corresponds with the setting in
Twido configuration. Following
two changes need to be applied
in addition:



Set the Preferred Frame
Length to Maximum
Possible
Enable the checkbox for
IEC61131 Syntax

Confirm the changes by clicking
OK.

3

Confirm the changes by clicking
OK.

4

A message pops up to inform
that all device addresses with
this equipment will be converted
to IEC61131 format. Click Yes to
confirm.
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5

To make the link between the
ModbusEquipment01 and the
Twido more obvious you can
rename the connection.
With a right mouse click on
ModbusEquipment01 a popup menu opens where you
select Rename.

6

Type in the new name, in this
example Twido.
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Create a new
variable

1

Right click on Variable.
Select from the pop-up menu
New Variable Æ New…

2

The New Variable dialog opens.
Change the Data Type of the
variable you wish to create by
selecting the desired data type
from the dropdown list.
In this example BOOL is
selected from the list.
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3

Type in the Variable Name, in
this example
HMI_Cmd_Mot_Up.
You can enter as well a
comment or explanation to this
new variable in the Description
field.

4

In order to communicate with the
Twido the variables must be
created in the same ScanGroup
(here: Twido) which is linked to
the previous steps Configure
the connection.
Click on the three dots button
[…] right to the Device Address
field.

5

The Modbus (RTU) pop-up
opens which allows you to locate
the address of the variable.
In this example the address
%M11 will be created.
Select from the dropdown list of
the Address field the item %Mi
and enter 11 for the Offset (i).
The address %M11 gets
displayed in the Preview.
Confirm the changes by clicking
OK and the pop-up menu
closes.
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6

To enter more variables repeat
the steps 2 to 5.
If you have finished entering new
variables, click OK to close the
dialog box.

Create a
switch

1

Click on the Switch icon in the
toolbar.

2

Select the position where you
want to position the switch by
opening the rectangle and
pressing Enter.

3

The Switch Settings dialog
opens automatically in its
General tab.

To link the variable to the switch
click on the bulb icon to browse
for a variable.
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4

Clicking on the bulb icon (as
indicated in the image above)
opens the Variables list.
Select as variable from the list
and click Enter.

5

Back in the Switch Settings
dialog, go to the Label tab.
Here select Label Type.
In the middle of this dialog you
can type in the label for the
switch.
Close the dialog box by clicking
OK.

6

The display now shows the new
button with the label you gave it.
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Create a
numeric
display

1

Click on the numeric display
icon in the toolbar.

2

Select the spot where you want
to position the display by
opening the rectangle and
pressing Enter.

3

The Numeric Display Settings
dialog opens automatically in its
General tab.
In Display Digits you you
canset the maximum number of
the digits to be displayed for
both integral and fractional part
of the value.
To link a variable to the display
click on the double bulb icon to
browse for a variable.
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4

Clicking on the double bulb icon
(as indicated in the image above)
opens the Variables list.
Select a variable from the list
and click Enter.

5

The variable is now linked to the
numeric display,
Click OK to close the dialog box.

6

The display shows the new
numeric display with the full
number of digits you defined.
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Create an
alarm and
alarm panel

1

To create an alarm follows
basically the same steps as the
creation of a new variable.
Right click on Variable.
Select from the pop-up menu
New Variable Æ New…

2

Enter in the Basic Properties
tab Data Type,
Variable Name and an optional
description.
In this example:
Data Type:
BOOL
Variable Name:
Alarm_01
Description:
Alarm message E-Stop
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3

Click on the three dots
button […] right to the Device
Address field.

4

Enter now the settings for
variable %Mi30.
To accept the changes and to
leave the Modbus (RTU) popup, click OK.

5

Now switch to the Alarm tab.
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6

Mark the Alarm checkbox to
enable the alarm handling
properties for this variable.
By default the alarm will be
triggered when the status of the
variable is set to status high.
Automatically this alarm is linked
to the Alarmgroup1.
Click on Alarm Message to
associate a text which will be
displayed when an alarm occurs.

7

The Alarm Message Editor
pops up, Enter in the field the
text for the message which will
be displayed in case the variable
%M30 is active.
Confirm and store the changes
by clicking OK. The dialog will be
closed.

8

The new alarm has now been
created. Close this dialog by
clicking OK.
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9

The internal alarm management
of the HMI will display the date
and time whenever this alarm
occurs.
By default the time management
capabilities of the panel are
switched off.
To activate this function click in
the Navigator area on the target
name and change in the
Property Inspector the Time
Management (underneath the
Startup options) to Enabled.

10 To create an alarm page in the
HMI create first a new
application screen.
With a right mouse click on Base
Panels a pop-up opens where
you select New Panel.
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11 A new panel is created with the
next free ID and a default name.

12 You can change the panel ID
and as well its name by easily
typing in.
In this example it is:
5: Alarm

13 Click on the Alarm Summary
icon in the tool bar.

14 Select the postion where you
wish to place the alarm summary
by opening a rectangle on the
display.
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15 The Alarm page is created on its
own panel.

Export Vijeo
Designer
project

1

To transfer a project from one
PC to another an export of the
project is required.
First of all any open project
needs to be closed.
Select from the menu
File Æ Close Project.

2

Right click on the project you
wish to export.
Select from the pop-up menu
Export Project…
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3

A window opens where you can
browse for the location the
export file should be stored in.
The default name of the export
file has the same name you
have given to the project. In this
example it is
Optimized_HW_Twido.
Click on Save to continue the
export.

Import Vijeo
Designer
project

4

A message window pops up to
inform you that the creation of
the export file
Optimized_HW_Twido.vdz
was successful.

1

To import an existing project
into Vijeo Designer, right click
on Vijeo-Manager in the
Navigator area.
Select Import Project… from
the pop-up menu.

Note:
Importing a project is not
possible if any project is still
open.
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2

A window opens where you can
browse to the location the
import file is stored in.
Select the desired file, in this
example
Optimized_HW_Twido.vdz

Click on Open to continue the
import.

Download
Program
to the HMI

3

A message window pops up to
inform you that the import of
the file
Optimized_HW_Twido.vdz
was successful.

1

To be able to download the
project to the HMI the correct
download communication must
be set.
Go in the Property Inspector to
the Download item and select
from the two options USB from
the dropdown list.
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2

Click on Build in the Menu bar
and select the item Download
Target.

3

Vijeo Designer connects now to
the HMI and begins the build
and download process. A dialog
box appears and requires your
attention.
To continue click Yes.

4

A dialog box pops up in case
the runtime version of the
connected HMI does not match.
Click on Yes to continue and
the latest runtime version will be
installed on the device.

5

The progress is shown in the
Downloading message box.

6

After completing the download
you receive a notification in the
Feedback Zone of Vijeo
Designer.

Optimized CANopen Twido

Schneider Electric

87

1
Screen
navigation in
the application
program

After a power up or a restart of
the HMISTU655 device the
screen on the right will appear.
.

2

You can click on the Date/Time
button to edit the date and time
of the HMISTO511 device. If no
action is taken the screen
switches after 10 seconds to the
start panel.

3

The Start panel shows the
architecture and offers on the
right hand side five buttons for
the available pages inside the
HMI.
The currently activated panel
highlights the respective button
by a yellow background.
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4

The Bus panel shows an
overview of the CANopen
status. It shows the master at its
top and lists underneath the five
CANopen slaves.
Status green Æ Device or
master not operational
Status red Æ Device or master
not operational
Status grey Æ No response
from devices because Master is
not operational

5

The Control Device 1-3 panel
contains the control elements
for the Altivar slaves 1, 2 and 3.
On the top you select the
Setpoint speed in Hz (on
controller startup it is always 10
Hz).
Below this field you can start
and stop the drive in both
directions with the help of the
pushbuttons.

6

The Control Device 4+5 panel
contains the control elements
for the Altivar slaves 4 and the
TeSysU.
For the ATV you select on the
top the Setpoint speed in Hz
(on controller startup it is always
10 Hz).
Below this field you can start
and stop the drive in both
directions with the help of the
pushbuttons.
For TeSysU you have the same
control elements but without
setpoint speed.
On the right the temperatures
from the Pt100 thermal probe
are displayed on the panel, too.
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7

The Alarm panel pops up when
an alarm occurs and shows the
text in the message list. As long
as an alarm is active the Alarm
button in the lower right corner
turns to red.
For alarms which can be reset
there is an Alarm Reset button
in the upper right part of the
panel.
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Devices
Introduction

This chapter describes the steps required to initialize and configure the devices to attain
the described system function.

General

Altivar 312 drives are configured by using the local control panel on the device itself.
Alternatively they can be configured by using the software SoMove Lite.

Note

If this is not a new drive you should re-establish the factory settings. If you need
instructions on how to do this, please read the drive documentation.
Be sure that the controller is in STOP state before parameterizing the drives.
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Altivar 312
Introduction

The ATV312 parameters can be entered or modified via the local control panel on the
front of the device itself or by using the software SoMove Lite.
The advantages of using the SoMove Lite software are:
• The data can be stored on the PC
• Documentation can be printed and
• The tool supports online optimization of the parameters.

Note

If this is not a new drive you should re-establish the factory settings. If you need
instructions on how to do this, please read the drive documentation.
The Jog dial that is a part of the local control panel can be used for navigation by turning
it clockwise or counter-clockwise. Pressing the jog dial enables the user to make a
selection or confirm information.

Procedure

Setting up the ATV is done as follows:
•
•
•
•

ATV312 Control Panel
Configuring ATV312 with SoMove Lite
Download the configuration
Connect to device / upload the configuration

To speed up the commissioning,
Preparation
first make a note of the motor data
for
commissioning found on the motor type labels (see
example on the right) This data
includes:
•
•
•
•

Nominal voltage
Nominal power
Nominal frequency
Power factor cos ϕ

Note:
Be sure that the controller is in
STOP state before parameterizing
the drives.
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ATV312
Control
Panel

The ATV312 parameters can be entered or modified via the control panel on the front of
the device. This section describes how to set up the drive using the local control panel.
Alternatively, you can use the SoMove Lite software to configure the CANopen
addresses and baud rate.
1 The CANopen address and
Baudrate can be input using
the buttons and the jog dial on
the front panel of the Altivar.

2

Using the buttons on the front
panel, select the sub-menu
Communication.

3

In the Communication submenu input the CANopen
address in the parameter
AdC0. In the example
application the adresses for the
four drives are 1 to 4.

4

Also in the Communication
sub-menu, in the parameter
BdC0, set the baudrate to
500.0 (kBits).
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5

For the ATV312 to operate with the new address or Baudrate, a power cycle (on,
off, on) is required.

WARNING
UNINTENDED EQUIPMENT OPERATION
After making any configuration changes or adjustments, be sure to cycle power (remove and
reapply power) on the drive.
Failure to follow these instructions can cause death, serious injury or equipment
damage.

Configuring
ATV312 with
SoMove Lite

1

After starting SoMove Lite you
will see the window as shown
here on the right – the version is
automatically shown in English.

2

To create a new Project, select
Create a Project OFF-line.

3

Select now the desired device
by clicking on the icon and
continue with Next.
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4

Select ATV312 from the
options. In the Device dialog,
select a Reference and the
Firmware Version.
In this example:
Reference:
ATV312H037N4
Version:
V5.1IEXX
Option Board:
CANopen
Additional information displayed:
- Supply Voltage
- Nominal Power
of the drive.

5

Continue with Create.
To save the project use
File–>Save as…
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6

Enter the File name (here
ATV312) and continue with
Save.

7

Connect now the RJ45 socket
on the drive with the USB port
on your PC by using the
programming cable
TCSMCNAM3M002P.

Note:
If you use the daisy chain option
board for the ATV312 the RJ45
connector for Modbus is on the
right.
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8

Select:
Communication->Edit
Connection
to go to the connection dialog.

9

Select Advanced to check and
edit the connection settings.

10 Select the appropriate COM
Port, here COM15 is used.
Baud Rate: 19200
Parity:
Even
Stop Bits: 1
Continue with OK.

Note:
If you don’t know which COM
port is assigned to the
TCSMCNAM3M002P USB
cable continue with step 11. If
you already know the COM port
go directly to step 13.
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11

The cable TCSNCNAM3M00P
is a USB cable and is linked by
Windows to a virtual COM port.
To identify the right COM port
you need to open the System
Properties dialog by clicking on
Windows key + Pause button.
Open up the Hardware tab and
click on Device Manager.

12

In the Device Manager click on
Ports (COM & LPT).
The cable is listed with the alias
name TSX C USB 485 with the
corresponding port in brackets.
In this case the port COM15 is
assigned to it.

13

You can perform a test of the
connection by clicking on Test.
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14

If the connection was
successfully tested you will get
the confirmation inside the
screen with a green hook.
Close this dialog box by clicking
OK.

15 Select:
Communication->Connect to
Device
to go to the connection dialog.

16 If the configuration of the device
is not same as given in the file.
Then user gets the following
warning.
Click Yes.
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17 Press Alt + F to continue.

18 The Main-Window of SoMove
consists of four tabs. The tab,
MyDevice, includes the basic
information about the device.

19 The tab, Parameters, shows a
table of all adjustable
parameters.

20 In the Motor data area enter the
values from the motor name
plate of your connected motor.
Note:
These parameters here are for
the machine described in this
example only.
In all likelihood, you will need to
adapt these parameters for your
specific machine.
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21 To adapt the CANopen
communication settings go to
the entry Communication.
In this example we use
CANopen address
ADCO: 1
CANopen baudrate
BDCO: 500 kbps
Note:
The other Altivars will get 2, 3
and 4 as CANopen address.
22 The tab, Errors Detection,
shows the current detected
faults.

23 The tab Monitoring, is used to
monitor the parameter values of
the drive. Click on the
parameter to be observed and
then click again on the plane on
the right hand side.

24 After entering the needed
parameter save it with:
File-> Save
or use the icon in the toolbar, to
save your configuration.
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Download the
Configuration

1

Check that the PC is connected
to the Altivar drive.
For this use the cable set
TCSMCNAM3M002P.

2

3

To download the configuration
to the drive click on icon in the
toolbar:
Store to Device.
A progress bar is displayed
during the download.
Click OK.

4

For the ATV312 to operate with the new address or Baudrate, a power cycle (on,
off, on) is required.

WARNING
UNINTENDED EQUIPMENT OPERATION
After making any configuration changes or adjustments, be sure to cycle power (remove and
reapply power) on the drive.
Failure to follow these instructions can cause death, serious injury or equipment
damage.
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Connect to
device /
upload the
configuration

1

To connect to the device click
the
Connect to Device icon in the
toolbar
Or select:
Communication->Connect to
Device

2

To upload the configuration to
the PC answer the question
that follows with
Yes.

3

The configuration in the PC file
will be overwritten.
You can also upload the
configuration from the device
into PC by clicking on the Load
Values from Device icon

And answer the question with
Yes.

4

A progress bar is displayed
during the upload.
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TeSysU
Introduction

This chapter presents the TeSysU motor components used in this system. They can be
adapted according to the application (motor output, reversing or non-reversing drive).
Basically, the TeSysU motor control unit comprises of a:
-

Power base
Control unit
Communication module
Coil wiring kit
Optional: reversing block, Is limiter/isolation block and other modules

The following points should be taken into account when selecting components:
A 24 Vdc LU2B xx BL control unit must be used. Make sure it has the BL extension.
There are different versions of the coil wiring kit, which depend on the power base.
LU9B N11C should be used if the power base has one direction of rotation (LU2Bxx)
and LU9M RL should be used if the power base has two directions of rotation (LU2Bxx).

TeSysU

1

TeSysU
Power base
LU2B12BL
Control unit
LUCA05BL
Communication module for
CANopen
LULC08 (1)
Coil wiring kit
LU9MRL (2)

2

TeSysU CANopen
communication module
LULC08

The communication module
is connected to the CANopen
bus using cable.
TSXCANCADD1
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3

TeSysU CANopen
communication module
LULC08
The baud rate is set to 500
kbps.

4

The following address is used: CANopen Node ID 5

5

Note: TeSysU needs 24 Vdc on CANopen cable to operate. See the chapter:
Communication: CANopen TAP: TSXCANTDM4 wiring.
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Appendix

Detailed Component List
The following tables are a list of the main components of the Optimized CANopen Twido
architecture.

Hardware components – Group 1: Cabinet (Circuitry, 24 Volt Supply, etc.)
Pos.

Qty.

Description

Part Number

Cabinet

1.1

1

NSYS3D12840P

Optional

1.2
1.3
1.4
1.5
1.6

1
2
1
1
1

Cabinet with mounting plate,
800 x 1200 x 400 mm (W x H x D)
Filter fan, 230 Vac, 165 m³/h
Outlet grille
Thermostat for Fan, 0..60°C, 1 NO
Phaseo Power supply 230 Vac / 24 Vdc, 5 A
Phaseo Power supply 230 Vac / 24Vdc, 5 A

Rev./
Vers.

NSYCVF165M230PF

NSYCAG223LPF
NSYCCOTHO
ABL8RPS24050
ABL4RSM24050

Hardware component – Group 2: Main Switch

Main switch

Pos.

Qty.

Description

Part Number

2.1

1

Compact main switch 3 pole 400 Vac

NSX100F

Rev./
Vers.

Hardware components – Group 3: Control components
Controller and
I/O modules

Pos.

Qty.

Description

Part Number

3.1
3.2
3.3

1
1
1

TWDLMDA20DRT
TWDNCO1M
TM2DMM24DRT

3.4

1

3.5

1

Twido modular controller, 12 IN / 8 OUT
CANopen master interface
TM2 digital I/O expansion module,
16 IN / 8 OUT
TM2 analog I/O expansion module,
4 IN / 2 OUT
TM2 analog I/O expansion module for
thermocouples and thermo probe

Rev/
Vers.

FW 5.20

TM2AMM6HT
TM2ALM3LT

Hardware components – Group 4: Drive and motor starter components
Drives & Motor
Starter

Pos.

Qty.

Description

Part Number

4.1
4.2
4.3
4.4
4.5
4.6

4
4
4
1
1
1

ATV312 variable speed drives 0.37 kW
ATV312 CANopen daisy chain option card
TeSys Motor circuit breaker 2.5 A
TeSysU Base unit for two directions
TeSysU Control unit
TeSysU CANopen interface

ATV312H037N4
VW3A31208
GV2L07
LU2B12BL
LUCA05BL
LULC08
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Hardware components – Group 5: HMI components
HMI

Pos.

Qty.

Description

Part Number

5.1

1

HMISTU655

5.2

1

HMI Magelis graphical operator display,
color
Communication cable Twido-HMI

Rev/
Vers.

XBTZ9780

Hardware components – Group 6: Safety related components
E-Stop & door
guarding

Pos.

Qty.

Description

Part Number

6.1
6.2
6.3

2
1
2

Preventa Emergency Stop safety relays
Harmony Emergency Stop pushbutton
Preventa guard switch

XPSAC5121
XB5AS844
XCSA502

Rev/
Vers.

Hardware components – Group 7: Pushbutton
Pushbutton

Pos.

Qty.

Description

Part Number

7.1
7.2
7.3
7.4

1
2
1
2

Harmony Box for 1 button
Harmony Signal lamp LED white
Harmony Pushbutton with LED red
Harmony Pushbutton with LED blue

XALD01
XB5AVB1
XB5AW34B5
XB5AW36B5

Rev/
Vers.

Software-Components – Group 8

Software and
cable

Rev./
Vers.

Pos.

Qty.

Description

Part Number

8.1
8.2
8.3

1
1
1

TWDBTFU10M
TSXCUSB485
TSXCRJMD25

V2.20.11

8.4
8.5
8.6

1
1
1

VJDSNDTGSV51M

V5.1 SP1

8.7

1

TwidoSuite Software
USB programming adapter
Cable for connecting programming adapter
to Twido
Vijeo Designer
Programming cable PC-HMI
SoMove Lite, available by download from
http://www.schneider-electric.com
Altivar connection cable for drives
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Component Protection Classes

Positioning
Protection
class

Cabinet
Component

In Field, On site
IP54

Harmony Emergency Stop switch
Emergency Stop switch housing
Master Switch NSX 100F
Rotating Door handle for master switch
TeSys motor protection devices and load
contactors
Contactors and fuses
Phaseo power supply
Emergency stop switches XPSAC***
Twido controller and expansion modules
Magelis HMISTU655 touch panel
Altivar 312 variable speed drive
CANopen Taps
Switch series ”Harmony“ in housing
Filter and filter fan
Fan thermostat
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Front
IP55
X

inside

IP65

IP20
X

X
X
X
X

X

X

X
X
X
X
X
X
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IP66
IP40
X
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Component Features
Components

Controller Twido
This example uses a Twido modular controller with TwidoSuite software and
programming cable set.
(TWDLMDA20DRT+ TWDBTFU10EF + TSXCUSB485 + TSXCRJMD25):
•
•
•
•

24 Vdc
12 digital inputs
8 digital relay outputs
expandable up to 7 modules

2 Programming Languages:
•
•

Ladder (LD)
Instruction List (IL)

Pre-defined functions:
•
•
•
•
•
•
•
•

Drum control
Fast counters up to 5kHz
Very fast counters up to 20 kHz
Frequency measuring 1..20 kHz
Reserved Memory for LIFO/FIFOprocessing
PWM-/PLS-Outputs
External controller-Start
PID-controller

CANopen master module TWDNCO1M
Master module for Twido logic controllers with:
•
•
•
•
•
•
•
•
•

Optimized CANopen Twido

Control of up to 16 Slaves (depends on
number of PDOs/SDOs)
Baudrates 125 / 250 / 500 kBit/s
Slave watchdog with Node Guarding or
Heartbeat
Configuration tool integrated in Twidosuite
Bus configurable through the backplane of
the controller
Integrated macros for quick installation
Slim format (30mm width)
Pluggable contacts for power supply
Configuration by controller during power
up
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Twido analog module TWDAMM3HT
•
•
•
•

4 x analog input 0..10 Vdc
4096 increments, 12-bit digital resolution
2x analog output 0..10 Vdc
4096 increments, 12-bit digital resolution

Safety Module: Preventa XPSAC5121

Main technical characteristics:
For monitoring
Max. category accord.
EN954-1
No. of safety circuits
No. of additional circuits
Indicators
Power supply AC/DC
Synchro time between inputs
Response time
AC-15 breaking capacity
DC-13 breaking capacity
Minimum voltage and current
Dimensions (mm)
Connection
Degree of protection

Optimized CANopen Twido

Emergency stop
4
3 N/O
3 LED
24 V
Infinite
< 40 ms
C300
24 Vdc /1.5 A - L/R 50 ms
17 V / 10 mA
114 x 22.5 x 99
Captive screw-clamp
terminals
IP20 (terminals)
IP40 (casing)
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Power Supply Phaseo: ABL8RPS24050
•
•
•
•

100..240 Vac / 24 Vdc, 5 A
Slim design
Parallel wiring possible
Short circuit and power surge protected

Magelis Display Terminal: HMISTU655
•
•
•
•
•
•
•

High-definition TFT QVGA with 24 Vdc
power supply
64k colors
Serial port RJ45 RS485/232 multiprotocol
interface
10/100 BaseT RJ45 Ethernet port interface
1 mini USB Device + 1 USB Host 2.0
interface
Temperature range: 0..+ 50 °C
Certificates: UL, CE, cULus, C-Tick

Altivar 312 Variable Speed Drive: ATV312H037N4

The Altivar 312 drive is a frequency inverter for 3-phase
squirrel cage asynchronous motors. The Altivar 312 is
robust, compact, easy to use and conforms to EN 50190,
IEC/EN 61800-2, IEC/EN 61800-3 standards UL/CSA
certification and to CE marking.
Altivar 312 drives communicate on Modbus and CANopen
industrial buses. These two protocols are integrated as
standard.
Multiple units can be mounted side by side to save space.
Drives are available for motor ratings between 0.18 kW
and 15 kW, with four types of power supply:
- 200 Vac to 240 Vac 1-phase, 0.18 kW to 2.2 kW
- 200 Vac to 240 Vac 3-phase, 0.18 kW to 15 kW
- 380 Vac to 500 Vac 3-phase, 0.37 kW to 15 kW
- 525 Vac to 600 Vac 3-phase, 0.75 kW to 15 kW

Optimized CANopen Twido
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TeSysU Motor starter

with CANopen interface
TesysU LU2B12BL+ LUCA05BL + LULC08

Magnetic Circuit breaker: GV2L07 and GV2L08
•
•
•

2.5 A / 4.0 A
Short circuit protected
Magnetic cut off at 33.5 A
lockable

TeSysD Contactor LC1D09BD
•
•
•
•
•

Optimized CANopen Twido

Rated current 9 A AC3
1x NO contact
1x NC contact
Positive opening operation allows for use
in functional safety circuits
24 Vdc control voltage incl. suppressor
circuit
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Contact

Homepage

http://www.schneider-electric.com

As standards, specifications and designs change from time to time, please ask for
confirmation of the information given in this publication.
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